
Chapter 1: Introduction  

Objectives  

This Manual for Secretariat Personnel has been prepared to serve as a guideline for 
the staff in units under the Office of the Vocational Education Commission (OVEC), so that 
personnel can perform their duties correctly, systematically, and in a referenceable manner. 
Additionally, it will facilitate convenient, fast, time-saving, and cost-effective operations, 
which will enhance the efficiency of the secretariat work in the OVEC-affiliated units. 

Importance/Role/Scope and Related Knowledge  

1. Importance of Secretariat Work  

1. Is the frontline/first point of contact for the unit. 

2. Is a support unit. 

3. Is a service unit. 

2. Role of the Administrative Officer  

1. Must know the relevant regulations. 

2. Must have good interpersonal relations. 

3. Must be helpful and kind-hearted. 

4. Must be cautious/meticulous. 

5. Must undergo continuous development. 

3. Scope of Secretariat Work  

1. Receiving and dispatching official documents/letters. 

2. Drafting official documents/letters. 

3. Typing official documents/letters. 

4. Producing copies of documents. 

5. Filing documents/submission files. 

6. Searching/Retrieval. 

7. Recording/submitting documents for approval. 



8. Proofreading official documents/letters. 

9. Destruction of official documents/letters. 

4. Knowledge Related to Secretariat Work  

1. Knowledge of the Prime Minister's Office Regulation on Secretariat Work B.E. 2526 
(1983) and its amendments, and currently, it is essential to have knowledge of the 
government agency's electronic secretariat system. 

2. Knowledge of the unit's codes and abbreviations. 

3. Knowledge of the nature of official documents, i.e., the document submission 
system. 

4. Knowledge of the internal organizational structure to correctly minute/endorse 
documents and submit them to the responsible person. 

Duties and Responsibilities  

1. Overall Main Duties : Secretariat work involves individuals and documents. The 
main duties concern receiving and dispatching official correspondence, both internal 
and external; drafting replies to official letters; drafting letters of request for support; 
typing official documents; document filing; circulating documents to various 
divisions/groups; and coordinating with relevant internal units. Secretariat work is 
responsible for carrying out administrative tasks and controlling the secretariat 
system for OVEC-affiliated units to ensure accuracy, speed, and efficiency. 

2. Specific Duties of Secretariat Work : 

• Directing, coordinating, and commanding secretariat tasks. 

• Analyzing and filtering internal and external matters for submission to the 
executive/administrator. 

• Drafting and replying to internal and external official correspondence, preparing 
orders, and official documents. 

• Publicizing urgent news/information. 

• Issuing order numbers and announcements for the Office of the Vocational Education 
Commission and its affiliated units. 

• Issuing external dispatch numbers. 



• Receiving matters from external units. 

• Arranging to submit documents for executive's command or signature. 

• Arranging to send circular letters to inform relevant divisions/groups. 

• Coordinating the receiving and dispatching of official documents from various units. 

• Receiving matters from OVEC-affiliated units for external dispatch to relevant external 
units. 

• Arranging to send letters and parcels for the Office of the Vocational Education 
Commission and its affiliated units. 

• Sorting mail. 

• Organizing files related to orders. 

• Typing official documents, memoranda, orders, regulations, bylaws, and various 
announcements. 

• Other assigned duties. 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 2:  

Definition, Types, and Formats of Official Documents 

Definition  

According to the Prime Minister's Office Regulation on Secretariat Work, official 
documents are documents that serve as official evidence, including: 

1. Documents exchanged between government agencies. 

2. Documents sent by a government agency to any other non-government agency or to 
external individuals. 

3. Documents sent to a government agency by any other non-government agency or 
external individuals. 

4. Documents prepared by the government for official evidence. 

5. Documents prepared by the government according to laws, regulations, or bylaws. 

6. Information, news, or documents received from the electronic secretariat system. 

Types of Official Documents 

There are 6 types of official documents: 

1. External Letter (หนงัสือภายนอก) 

2. Internal Letter/Memo (หนังสือภายใน) 

3. Stamped Letter (หนังสือประทับตรา) 

4. Commanding Document (หนังสือส่ังการ) 

5. Public Relations Document (หนังสือประชาสัมพันธ์) 

6. Document prepared by an official or received as official evidence (หนังสือท่ี
เจ้าหน้าท่ีทำขึ้น หรือรับไว้เป็นหลักฐานในราชการ) 

 

 

 

 



Formats of Official Documents 

1. External Letter (หนังสือภายนอก) A formal official correspondence using paper with 
the Garuda emblem (standard size 3 cm). It is used for communication between government 
agencies or from a government agency to any other non-government agency or external 
individual. (Recommended font: THSarabunIT9, size 16 Point). 

 



 

3. Internal Letter/Memo (หนังสือภายใน) An official correspondence that is less formal 
than an External Letter. It is used for internal communication within the same 
Ministry, Bureau, Department, or Province, utilizing memorandum paper with the 
Garuda emblem (standard size 1.5 cm). (Recommended font: THSarabunIT9, size 16 
Point). 



 
 
 
 



4. Stamped Letter (หนังสือประทับตรา) A document that uses a stamp in lieu of the 
signature of the head of a government agency at the Department level or higher, to 
be initialed by a delegated official. 

 



 

 

Usage: Used for non-critical matters, such as: 

o Requesting additional details. 

o Sending document copies, items, or documents. 

o Acknowledging receipt that does not concern important official matters or 
finances. 

o Notifying related government agencies of work already completed. 

o Reminding about overdue matters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



4. Commanding Document (หนังสือสั่งการ) There are 3 types: 

• Order (คำสั่ง): Statements whereby a superior commands action to be taken in 
accordance with the law. 

• Regulation (ระเบียบ): Statements laid down by an authorized person to be 
constantly adhered to as an operational principle. 

• Bylaw (ข้อบังคับ): Statements determined for use by an authorized person, based on 
specific legal authority. 



 

 



 

 

 



 

 

 



 

5. Public Relations Document (หนังสือประชาสัมพันธ์) There are 3 types: 

• Announcement (ประกาศ): Statements that the government announces or explains 
for public awareness or provides operational guidelines. 

• Statement/Communique (แถลงการณ์): Statements issued by the government to 
clarify official affairs, events, or any circumstances for widespread understanding. 

• News (ข่าว): Statements that the government deems appropriate to disseminate for 
public awareness. 



 

 



 

 



 

 



 

 



6. Document Prepared by an Official or Received as Official Evidence (หนังสือที่
เจ้าหน้าที่ทำขึ้น หรือรับไว้เป็นหลักฐานในราชการ) There are 4 types: 

• Certificate (หนังสือรับรอง): A document issued by a government agency to certify an 
individual, legal entity, or unit for a specific purpose to be presented to the general 
public. 

• Minutes of Meeting (รายงานการประชุม): The record of opinions and resolutions of a 
meeting to be kept as evidence. 



 

 

 



 

 

 



• Memorandum/Note (บันทึก): A message from a subordinate to a superior. 

 



• Other Document (หนังสืออื่น): Any other document or paper (including electronic 
media like tapes, disks, etc.) created by an official or formally registered by the 
government as official evidence. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 3: 

Formats for Printing Official Documents  

(รูปแบบการพิมพ์หนังสือราชการ) 

This chapter focuses on the detailed technical specifications for preparing official 
documents, ensuring consistency and adherence to government regulations. 

การกำหนดระยะบรรทัด (Line Spacing), การกั้นหน้าซ้ายขวา (Margins), การย่อหน้า (Indentation), 
วรรคตอน (Spacing), กรณีการพิมพ์หนังสือท่ีมีจำนวนหลายหน้า (Multi-page Documents), การเขียน "ส่ิง
ท่ีส่งมาด้วย" (Attachments), และ การใช้วงเล็บ (Parentheses) เป็นภาษาอังกฤษให้ค่ะ 

From the above line spacing, the following can be analogized to set the line spacing for 
typing official documents using a computer: 

1. Method One (Enter Key) Pressing the Enter key to type the next line (equivalent to 
Spacing 1). Moving the CURSOR to the end of the previous line and pressing the Enter key 
once will make the line spacing currently set turn into Spacing 3. If you want to adjust the 
line spacing to Spacing 2, reduce the font size from the current working size. If you are typing 
with TH SarabunPSK font size 16, reduce it to size 8; the line spacing will adjust to Spacing 2. 

2. Method Two (Paragraph Menu - Spacing) Click on the “Format” menu item, click 
on the “Paragraph” menu item, and select the “Spacing” option. Setting the Before and 
After values to 6 points is equivalent to Spacing 2. If the value is set to 12 points, it is 
equivalent to Spacing 3. 

3. Method Three (Paragraph Menu - Line Spacing) Click on the “Format” menu item, click 
on the “Paragraph” menu item, and select the “Line spacing” option as follows: 

1. Single = Spacing 1 

2. 1.5 lines = Spacing 2 

3. Double = Spacing 3 

4. Indentation Tab Stop In addition to setting line spacing for typing official documents, 
the paragraph indentation is set to 10 keystrokes. When using a computer with the TH 
SarabunPSK font, size 16 point, set the Tab stop to 2.54 centimeters or 1 inch. This tab 
distance will be close to 10 keystrokes. 

 

 



Left and Right Margins (การก้ันหน้าซ้ายขวา) 

The left and right margins should be set to 3 centimeters on the left side of the 
paper and 2 centimeters on the right side. However, the right side is not strictly enforced and 
does not need to be justified (straight alignment). The issue arises because t ypists or 
supervisors believe that justification looks neater and more orderly. In reality, this often 
causes more harm as it leads to incorrect word breaks (in Thai). Even though word processing 
programs can compress or expand characters, this should not be done as it distorts the 
spacing between characters. Therefore, when typing, prioritizing the correctness of the breaks 
and spacing is essential. The right margin should be left loose but should not be less than 2 
centimeters. 

Paragraph Indentation (การย่อหน้า) 

According to the prescribed format, the indentation must be 8–15 characters from 
the left edge, or approximately 18 keystrokes (2.54 cm or 1 inch). For aesthetic purposes, 
approximately 13 characters is preferred. The font size used should be 16 points. Computers 
allow for setting the desired paragraph indentation or Tab (by pressing Tab twice) and the 
font type should be TH SarabunPSK or TH SarabunIT9 as required on a case-by-case basis. 

Word Spacing/Punctuation (วรรคตอน) 

In writing or typing Thai documents, the Royal Institute has set standards for correctly 
spacing between words, phrases, or sentences. This is considered very necessary because it 
ensures that the written piece is correct, clear, specific, and accurately conveys the writer’s 
intent regarding different words, phrases, or sentence segments. Word spacing refers to 
leaving a gap between segments. 

Word spacing (วรรคตอน) is defined into 2 types: 1 character space (Small Spacing) and 
2 character spaces (Large Spacing) (based on typewriter standards). However, most typing is 
now done on computers where 1 Spacebar press is generally equivalent to the Small 
Spacing, and 2 Spacebar presses are generally accepted as equivalent to the Large Spacing. 

Case of Multi-Page Documents (กรณีการพิมพ์หนังสือท่ีมีจำนวนหลายหน้า) 

If a document spans multiple pages, type the / symbol followed by 2–3 words of the text 
that will be carried over to the next page, and then follow with ... (three dots). Typically, this 
should be spaced 3 printing lines down from the last line of text on the current page. 

 



Writing "Attachments" (การเขียน “สิ่งที่ส่งมาด้วย”) 

The document or item being sent must be clearly specified. If it is a document, the 
type of document or item and the quantity must be stated, e.g., "Meeting Minutes, 5 sheets," 
"Training Project, 3 sheets," "Books, 2 volumes," etc. Writing only the word "Document" 
(เอกสาร) should be avoided as it is unclear what document it is. 

For the document quantity, using the word "sheet" (แผ่น) is clearer and more 
convenient for counting, whereas the word "copy" (ฉบับ) may not clearly indicate how many 
sheets are included. 

Use of Parentheses ( )  

The use of parentheses ( ) or Nokhalikith (นขลิขิต) is a punctuation mark used to 
enclose text that expands upon or explains other text. The Royal Institute specifies that if 
the parentheses are at the end of a sentence or the end of a paragraph, they are not 
necessary because the context is already clear and does not interfere with other text. 
However, if they are placed within the text, parentheses should be used, such as (Attached 
Document 1) or (Details according to Attachment 1). This is to prevent obstructing the flow 
of the text that has not yet concluded. 

Word Breaking at the End of a Line (การตัดคำเม่ือสิ้นสุดบรรทัด) 

Word breaking is used primarily for two important characteristics: 

1. When a word at the end of a line cannot fit completely: In this case, a hyphen (-) 
must be inserted after breaking the word. However, careful consideration is needed. Words 
whose meaning changes after being broken should not be split, such as แม่-น้ำ (Mae-Nam - 
Mother-Water), การ-ศึกษา (Karn-Sueksa - Action-Study), ยก-ตัวอย่าง (Yok-Tua-Yang - Lift-
Example), ควบ-คุม (Kuab-Khum - Control-Supervise), ประ-ธาน (Pra-Thaan - President-Chair). 
Furthermore, words that are phonetically linked should not be split, such as ราช-การ (Ratcha-
Karn - Royal-Task) and รัฐ-บาล (Rath-Baal - State-Rule). Words that belong to a single semantic 
unit also should not be split, such as กระ-ทรวง (Kra-Suang - Ministry), สำนัก-งาน (Samnak-
Ngaan - Office-Work), บัญ-ชี (Ban-Chee - Account-List), ท่ี-ปรึกษา (Thee-Pruek-Sa - Place-
Consult), เอก-ชน (Aek-Chon - Private-Person). If splitting is deemed absolutely necessary, 
compression or expansion of the characters in that line should be used instead. 

2. To improve the aesthetic appearance of the document format: In this case, 
judgment should be used as appropriate without using a hyphen (-). For example, if the last 
word is a common conjunction or linking phrase, such as ซึ่ง (which), จึง (therefore), โดย (by), 



เรื่อง (topic), เมื่อ (when) (เมื่อวันท่ี - when on the date), or เพื่อ (for), which frequently falls at 
the end of a line, these linking words should be moved to the beginning of the next line. 

The concluding phrase in official correspondence should be appropriate for the 
recipient as follows: 

1. At the same level or to a subordinate: Use the phrases "ขอขอบคุณ" (Thank you) or 
"ขอบคุณมาก" (Thank you very much). 

2. At a higher level (but not the 14 highest officials below): Use the phrase "จะขอบคุณ
ยิ่ง" (Would be highly grateful). 

3. At the "Krab Rien" (กราบเรียน) level, as specified by the Prime Minister's Office Letter 
No. Nor. 1305/W 5239 dated July 7, B.E. 2541 (1998): Use the phrase "จะเป็นพระคุณยิ่ง" (Would 
be a greater kindness/honor), which applies to the following 14 positions: 

1. President of the Privy Council 

2. Prime Minister 

3. President of the Parliament 

4. Speaker of the House of Representatives 

5. President of the Senate 

6. President of the Supreme Court 

7. Statesman 

8. President of the Constitutional Court 

9. President of the Supreme Administrative Court 

10. Chairman of the Election Commission 

11. Chairman of the National Human Rights Commission 

12. President of the National Anti-Corruption Commission 

13. Chairman of the State Audit Commission 

14. Ombudsman of the Parliament 

Note on ฯลฯ: There is no regulation mandating the use of the title ฯลฯ (His/Her 
Excellency) in official documents. Although it is often encountered in correspondence 
addressed to the Prime Minister, it is currently advised not to use it. 



1. Study of Delegated Authority: Secretaries working in the office of an executive 
should especially study the Orders of Delegation of Authority, such as the acting and 
delegated performance orders, to know the scope within which the supervisor can sign 
documents without needing to propose them to a higher-level supervisor. 

• When typing the phrases "รักษาราชการแทน" (Acting for) and "ปฏิบัติราชการแทน" 
(Performing on behalf of), these two phrases must follow the position of the 
delegated official, using a small space (วรรคเล็ก) between them. 

2. Stamping of Documents: Stamping words like "สำเนา" (Copy), the urgency level ("
ด่วน" - Urgent, "ด่วนมาก" - Very Urgent, "ด่วนท่ีสุด" - Most Urgent), and the secrecy level ("ลับ" - 
Secret) must be done in the correct and neat position or location on the document. 

3. Attaching Source Documents: Attaching source documents or any referenced 
attachments (e.g., documents listed as Attachments/สิ ่งที ่ส่งมาด้วย) should be placed 
immediately after the original official letter that is to be sent to the external agency. 

4. Flagging Documents : The official responsible for the matter in every 
department/unit/center/group must personally place the flag. If no flag is attached, the front 
office secretary must attach it and check the completeness before submitting it to the 
executive. 

5. Organizing Documents for Submission to the Supervisor: The following best 
practices should be followed when putting documents into a file for submission: 

1. A cover sheet (ใบคุมเรื่อง) must be included in every file submitted. 

2. Matters with a security classification (ช้ันความลับ) must be placed in a separate file and 
submitted according to the regulations concerning government secrets. 

3. Matters with an urgency classification (ชั้นความเร็ว) must be placed in a separate file 
from general matters, and the person proposing the matter must follow up on it 
specifically. 

4. For any matter that the supervisor takes out for separate consideration, a record 
must be made on the cover sheet of the submitted file. 

Appendix (ภาคผนวก) 

 

 



Chapter 4: 

Concepts for Work Analysis and Systematic Drafting of Official Documents  

(แนวคิดการวิเคราะห์งานและแนวคิดในการร่างหนังสือราชการอย่างเป็นระบบ) 

In the routine work involving official letters or documents, two important principles are 
introduced here to enable personnel in secretariat work to fully understand the essence of 
incoming letters, as well as to systematically and efficiently analyze, synthesize, and draft a 
response or proposal to their supervisor. The two key principles are: 

1. IPSA Model 

2. Inverted Triangle Principle 

IPSA Model 

The IPSA model is a concept for the systematic analysis of work and drafting of 
official documents to improve work efficiency. It consists of the following components: 

Component Term Explanation 

I Ideal (อุดมคติ) 

Refers to the significance of the substance and content that 
serves as a principle, legal basis, or the origin of the letter or 
matter being drafted for submission to the supervisor, such as 
laws, government policy, ministerial/departmental directives, or 
directives from the parent agency. This is to establish the source 
and the important principles that necessitate action on that 
matter. 

P 
Problem 
(ปัญหา) 

The official must be able to analyze and understand the 
problematic issues of the incoming letter, as well as be able to 
identify the nature of the problem to be drafted in the letter to 
the supervisor. 

S 
Solution 
(แนวทาง
แก้ปัญหา) 

This is the suggestion of a concept or method to resolve the 
issue in the letter, or the approach to problem-solving to be 
proposed for the supervisor's consideration, approval, or 
command regarding the work problem. 



Component Term Explanation 

A 
Application 
(ประโยชน์ท่ี
ได้รับ) 

This involves stating the benefits to be gained after the 
problem-solving action has been implemented. 

 

 

 

 

 

 

 

 

 



Chapter 5: 

Using Technology to Enhance the Efficiency of Secretariat Work Operations  

(การใช้เทคโนโลยีช่วยเพิ่มประสิทธิภาพในการปฏิบัติงานสารบรรณ) 

This manual will recommend guidelines for using modern technology to assist in 
secretariat work operations in order to facilitate and enhance the efficiency of personnel 
performing secretariat duties, as follows: 

1. Using Microsoft Word program for preparing official documents. 

2. Importing text data (Text) into Microsoft Word program. 

Using Microsoft Word program for preparing official documents 

To manage document work and printed documents so that they have a neat, 
aesthetically pleasing, and systematic format, Microsoft Word can be utilized. We will 
introduce the following necessary special functions: 

Setting Up Styles (การต้ังค่า Style) 

Styles are tools used to format documents systematically and conveniently for the user, 
such as defining document headings, setting document indentation, etc. The steps for 
setting and using styles are as follows: 

1. After the page settings are complete, type the main heading, such as "Chapter 1," 
and then assign it as Heading 1 by selecting Style → click on Heading 1 → select 
Update Heading 1 to Match Selection, as shown in the image. [Image reference] 

 

 



2. For creating other sub-headings (Heading ย่อยอื่น ๆ): This can be done in the same 
manner as item 1. [i.e., typing the sub-heading, highlighting it, selecting Style → Heading 2 
(or subsequent headings) → Update Heading to Match Selection]. 

3. In case you want to define your own Style for use in the document, proceed as 
follows: 

3.1 Define the desired Tab distance and Font. 

3.2 Place the Cursor on the line for which you want to define the Style → select Save 
Selection as a New Style. 

3.3 Set the Style name, for example, p001, as shown in the image. This will serve as a 
Style to be selected for text that requires an indentation distance consistent with the first 
paragraph later on. [Image reference] 

        

 

 

 



2. Select the Replace command in the Home menu and set the values as follows: 

In the Find what box, press the Space bar once, and in the Replace with box, press 
Ctrl+Shift+Space bar. Then click Replace All. 

This action will display a "dot-dot-dot" symbol (or non-breaking space symbol) instead of 
a regular dot, indicating that the word spacing of the text has been fixed/locked (using 
non-breaking spaces), as shown in the image. 

 

 

 

 

 

 

 



 

 

 



Importing Text Data into Microsoft Word (การนำข้อมูลตัวหนังสือเข้าในโปรแกรม) 

Text data can be imported into the Microsoft Word program using the following 
methods: 

1. Manual typing by the user. 

2. Converting audio files to text using Speech recognition programs. 

3. Converting image files to text. 

Converting Audio Files to Text using Speech Recognition Programs 

Speech recognition programs are applications designed to convert human speech signals 
into text for input into the Microsoft Word program. This manual recommends two free 
applications for converting audio files to text: Google Docs and Voice Note, as follows: 

• Google Docs 

The steps for using Google Docs to convert voice messages into text are: 

1. The user must sign up for a Gmail account to receive a Username and Password. 
The user will also receive 15 gigabytes of Google Drive storage space for personal 
data storage. 

2. Open Google Chrome as the working browser and sign in to Google Chrome, as 
shown in the image. [Image reference] 

 

 

 

 



 

 

 



 

 

 



 

 

 



 

 

 



 

 

 



 


